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Legal Notices
Warranty
The only warranties for products and services of Micro Focus and its affiliates and licensors (“Micro Focus”) are set forth in the express warranty statements accompanying
such products and services. Nothing herein should be construed as constituting an additional warranty. Micro Focus shall not be liable for technical or editorial errors or
omissions contained herein. The information contained herein is subject to change without notice.

Restricted Rights Legend
Confidential computer software. Except as specifically indicated otherwise, a valid license from Micro Focus is required for possession, use or copying. Consistent with FAR
12.211 and 12.212, Commercial Computer Software, Computer Software Documentation, and Technical Data for Commercial Items are licensed to the U.S. Government
under vendor's standard commercial license.

Copyright Notice
© 1994-2018 Micro Focus or one of its affiliates.

Trademark Notices
Adobe® is a trademark of Adobe Systems Incorporated.
Microsoft® and Windows® are U.S. registered trademarks of Microsoft Corporation.
Oracle and Java are registered trademarks of Oracle and/or its affiliates.
UNIX® is a registered trademark of The Open Group.
Linux® is the registered trademark of Linus Torvalds in the U.S. and other countries.

Disclaimer
Certain versions of software and/or documents (“Material”) accessible here may contain branding from Hewlett-Packard Company (now HP Inc.) and Hewlett Packard
Enterprise Company. As of September 1, 2017, the Material is now offered by Micro Focus, a separately owned and operated company. Any reference to the HP and Hewlett
Packard Enterprise/HPE marks is historical in nature, and the HP and Hewlett Packard Enterprise/HPE marks are the property of their respective owners.

Documentation Updates
To check for recent updates or to verify that you are using the most recent edition of a document, go to: https://softwaresupport.softwaregrp.com.
This site requires that you register for a Software Passport and to sign in. To register for a Software Passport ID, click Register for Software Passport on the Micro Focus
Support website at https://softwaresupport.softwaregrp.com.
You will also receive updated or new editions if you subscribe to the appropriate product support service. Contact your Micro Focus sales representative for details.

Support
Visit the Micro Focus Support site at: https://softwaresupport.softwaregrp.com.
This website provides contact information and details about the products, services, and support that Micro Focus offers.
Micro Focus online support provides customer self-solve capabilities. It provides a fast and efficient way to access interactive technical support tools needed to manage your
business. As a valued support customer, you can benefit by using the support website to:
l
l
l
l
l
l
l
l

Search for knowledge documents of interest
Submit and track support cases and enhancement requests
Download software patches
Manage support contracts
Look up support contacts
Review information about available services
Enter into discussions with other software customers
Research and register for software training

Most of the support areas require that you register as a Software Passport user and to sign in. Many also require a support contract. To register for a Software Passport ID,
click Register for Software Passport on the Micro Focus Support website at https://softwaresupport.softwaregrp.com.
To find more information about access levels, go to: https://softwaresupport.softwaregrp.com/web/softwaresupport/access-levels.
Integration Catalog accesses the Micro Focus Integration Catalog website. This site enables you to explore Micro Focus Product Solutions to meet your business needs,
includes a full list of Integrations between Micro Focus Products, as well as a listing of ITIL Processes. The URL for this website is
https://softwaresupport.softwaregrp.com/km/KM01702731.
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Security enhancements

What's new in this release
This section describes important changes in this release.

Security enhancements
HTML Editor whitelist enabled by default
The HTML Editor enables users to visually add and edit rich text content formatted with HTML tags.
Though the HTML Editor is powerful, web sites may be abused without a proper security control. The
HTML editor whitelist is now enabled by default and you can use the HTML Editor whitelist to define a
list of allowed HTML elements.
To define a list of allowed HTML elements, follow these steps:
1. Log on to Service Manager as a system administrator.
2. Click Tailoring > Whitelist > HTML Editor Whitelist.
3. Define a list of allowed HTML Tags and attributes in the Allowed Tags/Attributes section. For
example, add script as an allowed tag so that you are able to input the <script> tag by using
the HTML Editor.
4. Define a list of allowed URL protocols for some elements in the Allowed URL Protocols section.
For example, add a as an allowed tag, specify href as the attribute, and then specify one or more
protocols that are used by the href attribute, such as http, https, mailto and ftp.
5. Click Save and OK.
6. Do either of the following to make the customized HTML Editor whitelist effective:
o

Restart the web application server if you are working with the Service Manager web client.

o

Log out and then log on to the Service Manager Windows client again.

After the HTML Editor whitelist became effective, you are only allowed to input the elements as listed
in the whitelist when editing HTML contents using the HTML Editor. The system automatically
validates your inputs and displays some warning messages if there are tags, attributes or protocols that
violate the whitelist. For example:

Micro Focus Service Manager (9.35)
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Embedded Tomcat Upgraded (Server and Knowledge Management)

The HTML document contains some tags <script>,<javascript> that are not allowed by
the system. Contact your Service Manager system administrator for assistance.
The HTML document contains some attributes for tags (<tag attribute...>) <div
onlick>,<p onerror> that are not allowed by the system. Contact your Service
Manager system administrator for assistance.
The HTML document contains some values in the attributes of tags (<tag attribute>)
<img src>,<a href> that are not allowed by the system. Contact your Service Manager
system administrator for assistance.
You must review your input and avoid using these invalid tags, attributes, or protocols. Alternatively,
you can ask your Service Manager system administrator to include these tags, attributes or protocols
to the whitelist. Otherwise, the system automatically removes these invalid elements from your input
after you click Save in the HTML editor.
Caution: Service Manager provides a default whitelist for tags, attributes or protocols that are
allowed in Service Manager out-of-box knowledge documents. We recommend that you enable
this enhancement. However, your HTML documents may contain tags, attributes, or protocols that
are not defined in the whitelist. We recommend that the Service Manager system administrators
perform extensive tests in the development environment and add all necessary tags, attributes, or
protocols to the whitelist before enabling the HTML Editor whitelist. Otherwise, enabling the HTML
Editor whitelist without prior tests may cause data loss to the existing knowledge documents in the
production environment.

Embedded Tomcat Upgraded (Server
and Knowledge Management)
This patch release upgrades the embedded Tomcat in the Service Manager server and Knowledge
Management (KM).
Server
The server embedded Tomcat has been upgraded to version 6.0.53.
Knowledge Management (KM)
The Knowledge Management (KM) embedded Tomcat has been upgraded to version 6.0.53.

Micro Focus Service Manager (9.35)
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Server

Enhancements
This release includes the following enhancement type fixes.

Server
CR

Problem

QCCR1E137664 When you try to load a modified dbdict file into a
system in which the target dbdict file already
exists, you receive the following error message:
dbdict already exists, cannot change this you
need to create a new file system.

Micro Focus Service Manager (9.35)

Solution
Run the sm -svc_import svc_updatedbdict
command to update the
dbdict file.
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Mobility

Fixed defects
This release fixes the following defects.

Mobility
CR

Problem

Solution

QCCR1E138601 You cannot log in to the Mobility client in
Chrome 56.

You can now log in to the Mobility
client in Chrome 56.

QCCR1E146687 If you update the Activity Type option in an
Interaction detail form and then click the
Back button, the mobility page keeps
loading and hang.

Now you can switch back to the
Interaction list page after you click
the Back button in an Interaction
detail form.

QCCR1E131554 The page stops responding when you save
journal updates on the Mobility client.

Now you can save the record
successfully when saving journal
updates on the Mobility client.

SRC
CR

Problem

Solution

QCCR1E142745 When you open an Interaction in SRC, the system displays the
user selections correctly. However, when you open a second
Interaction and then return to the first one, the values from the
existing user selections in the second Interaction will be populated
to the first Interaction.

Now the
system
displays the
user
selections
correctly.

Server
CR

Problem

QCCR1E108399 When you log on to Service Manager as a

Micro Focus Service Manager (9.35)
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Inbox query is optimized to
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Server

CR

Problem

Solution

power user, all the items in the Todo queue are
counted even when you are not going to view
them. When the inbox record number grows to
1,000,000, the response time is more than 6
seconds for each query and the CPU cost is
even higher in a concurrent environment.

improve the system
performance.

QCCR1E120644 When creating tickets (Incident, Change,
Problem, and so on), you need to use the"Get
Number" operation to get the ID of tickets. In a
concurrent scenario, the"Get Number"
operation is a potential bottleneck.

Now the "Get Number"
operation is optimized in a
concurrent scenario.

QCCR1E121418 The UCMDB Browser URL is truncated when
the URL includes a semi-colon (;).

Now the UCMDB Browser
works fine when the URL
includes a semi-colon (;).

QCCR1E134651 After you upgrade Service Manager, the
sequential number file issues incorrect SQL to
the back-end Oracle database in SQL.
Additionally, you receive the following error
messages:

Now the hard-coded
"NUMBER" column in the SQL
statement is replaced by the
real SQL column name in the
"number" file in dbdict.

RTE E Error: SQL code=904 message=ORA00904: "NUMBER": invalid identifier
RTE E API=OCIStmtExecute [in
sqociOpen], Statement=SELECT "NUMBER",
"SYSMODCOUNT"FROM NUMBERM1 WHERE
"NAME"='cm3r' FOR UPDATE

Note: After you upgrade
from SC6,you must map
the "number" field in the
"number" file in dbdict to
the real SQLcolumn (that
is, "NUMBERPRGN").

QCCR1E136244 Terminated sessions are not cleaned up until
all available connections are used and users
can no longer log in to Service Manager.

This issue is caused by a
database lock that is not
released when an exception
occurs. This lock is now
always released.

QCCR1E136718 When you try to unload a device or pcsoftware
table, the unload process never finishes.

Now when you try to unload a
device or pcsoftware table, the
unload process finishes as
expected.

QCCR1E137249 Image files are not listed in the Insert Image
wizard in the HTML Editor when the HTML
Editor whitelist feature is enabled.

Image files are now listed in
Insert Image Wizard and can be
successfully inserted when the
HTML Editor whitelist feature is
enabled.

QCCR1E139149 You cannot exclude the dbdict file from an
update by using the -svc_

You can now use the -svc_
excludefiles:dbdict option

Micro Focus Service Manager (9.35)
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Web client

CR

Problem

Solution

excludefiles:dbdict option with the svc_
import command

to exclude dbdict files from an
update with the svc_import
command.

QCCR1E139714 When you run the sm -svc_export command to
generate XML files, the file names do not allow
UTF-8 symbols and do not have limited
lengths.

Now the system includes a
new parameter svc_unicode.
When you run the sm-svc_
export command to generate
XML files, the file names can
contain UTF-8 symbols on
Windows OS if this parameter
is set to "1".

QCCR1E140536 The Date/time format of xml files generated by
svc_export with svc_mode:2 is always
mm/dd/yyyy.

A new parameter (svc_
dateformat) is added. The
possible and default values of
the parameter are the same as
those of the sqltextdateformat
parameter.
The svc_dateformat parameter
is used when performing "svc_
import" and"svc_export", and
the "on-line export" with "svc_
mode:2".

QCCR1E142536 KM stops responding when you click the
Search button very rapidly (for example, 3 to 4
times in a second).

KM does not hang in this
situation.

QCCR1E142929 The Key tab in dbdict does not pick up key field The Key tab in dbdict now picks
name modifications.
up key field name
modifications.
QCCR1E142945 During an svc export operation, the xml file
cannot be created if the file name is too long.

The xml file can be
successfully created no matter
how long the file name is.

Web client
CR

Problem

QCCR1E126558 In Internet Explorer, when you print a detail
form that contains a label and a text area, the
print preview looks good, but overlapping text

Micro Focus Service Manager (9.35)

Solution
The page now can be printed
properly by using Internet
Explorer.
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Windows client

CR

Problem

Solution

is shown when you select to print to a PDF or
printer.
QCCR1E135415 When you change your selection in a Comfill
field with auto complete enabled, the content
in the related field is not refreshed.

Now the content in the Subform
can refresh accordingly.

QCCR1E139552 When you enter a value in a Comfill field and
then move the focus out of the Comfill, you
cannot clear the value entered in the Comfill.

When you enter a value in a
Comfill field and then move the
focus out of the Comfill, you can
clear the value entered in the
Comfill now.

Windows client
CR

Problem

QCCR1E145588 In the SM Windows client, the ComFill
widget does not work properly when the
"Select Only" attribute is set to true.

Micro Focus Service Manager (9.35)

Solution
The ComFill widget now works
properly in the Windows client when
the "Select Only" attribute is set to
true.
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Known problems, limitations, and
workarounds
This software release has the following known issues and limitations. This is a cumulative list of known
issues and limitations in Service Manager, including those that are already documented in previous
release notes.

Issues in Service Manager 9.35 P4
Global ID

Problem

Workaround

QCCR1E130718

When you rotate the screen of
an iOS9-based device to
landscape and then back to
portrait, the Mobility client
page is incorrectly displayed.

To work around this issue, refresh the
browser.

Issues in Service Manager 9.35 P3
Global ID

Problem

Workaround

QCCR1E129407

Service Manager does not
work properly with Oracle 12c
when MAX_STRING_SIZE is
set to EXTENDED.

No workaround is available.

Issues in Service Manager 9.35 P2
Global ID

Problem

Workaround

QCCR1E127396

Memory leaks in
Oracle Client
12.1.0.1.0 and
12.1.0.2.0.

If you have an Oracle support account, download and
apply the latest bundle patch 12.1.0.2.8 at
https://updates.oracle.com/Orion/PatchDetails/process_

Micro Focus Service Manager (9.35)
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Global ID

Problem

Workaround
form?patch_num=21454170. Otherwise, use Oracle
Client 11.2 (11.2.0.3 or later).
Note: After changing the Oracle Client, SM Server
may not able to start up and you notice below
message in sm.log, please follow the guide in
Service Manager online help to configure the
allowunsupporteddbversion parameter.
Detected an unsupported version of Oracle
Client. To override this please enable the
parameter [allowunsupporteddbversion] and
restart Service Manager to continue.

QCCR1E127732

The page will hang
after you try to fill
incident
subcategory on
Android Chrome
version 44.

Refresh the page when page hangs.

Issues in Service Manager 9.35 P1
Global ID

Problem

Workaround

QCCR1E123523

In accessible mode,
unexpected blank place is
displayed for image menu
items of the menu brought up
by the "Show hidden menu"
button.

No workaround is available.

QCCR1E123833

In Internet Explorer (IE) 9, the
state of a disabled button
cannot be read by JAWS 13.

Use a supported browser other than IE 9.

Issues in Service Manager 9.35
Global ID

Problem

Workaround

QCCR1E115514

The auto complete

No workaround is currently available.
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Issues in Service Manager 9.35

Global ID

Problem

Workaround

functionality for the Comfill
control does not work properly
for the Link to Parent
Incident field of the Incident
from.
QCCR1E120737

The service filter in the
Interaction Hot Topic page
does not display a list of
values for user selection.

No workaround is currently available.

QCCR1E120360

The default value of the date
field cannot be submitted in
the Arabic version of Service
Request Catalog.

No workaround is currently available.

QCCR1E121885

A duplicated line appears
when you input some
characters in the HTML
Editor.

You can use one of the options below to
solve the issue:
l

l

QCCR1E122315

Users who use the LDAP
integration see the following
error message when they log
in to Service Manager 9.35 for
teh first time:
The system requires you
to choose a new
password. That password
has been used before.

Move the mouse out of the HTML Editor
for a while.
Click Source twice.

Click System Administration > Base
System Configuration > Miscellaneous
> System Information Record,
Passwords > Password Standards, and
then clear the Keep Password History
check box.

QCCR1E122316

For users who use the LDAP
integration, if their passwords
meet the LDAP password
policy but not the Service
Manager password policy,
they cannot log in to Service
Manager.

Click System Administration > Base
System Configuration > Miscellaneous
> System Information Record,
Passwords > Password Composition,
and then make the Service Manager
password policy weaker than the LDAP
password policy.

QCCR1E122448

An error message is displayed
when users request a service
item from the Service
Request Catalog Hebrew user
interface and they cannot
submit the request
successfully.

You can create the service item in English
and then set the locale to Hebrew. After
that, users can submit requests for the item
from the Service Request Catalog Hebrew
user interface successfully.

Micro Focus Service Manager (9.35)
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Issues in Service Manager 9.34 and patches

Global ID

Problem

Workaround

QCCR1E109833

Service Manager crashes
when you use the Open
Localization Toolkit to create
a language pack.

Update the OOB_UPG_COMPLETE
message and the CUSTOM_UPG_
COMPLETE message following the steps
below:
1. Log in to Service Manager as a system
administrator.
2. Type db in the Service Manager
command line, and then press Enter.
The Database Manager opens.
3. Type scmessage in the Table field,
and then click Search.
4. Click message.edit.
5. Type upgin the Class field, type OOB_
UPG_COMPLETE in the Message
Number field, and then click Search.
6. Change the description in the Text field
to upgrade is only for
English version.
7. Click Save and OK.
8. Type upg in the Class field, type
CUSTOM_UPG_COMPLETE in the
Message Number field, and then click
Search.
9. Change the description in the Text field
to We need to update this
message. Otherwise, sm will
crash when create language
builder.
10. Click Save and OK.

Issues in Service Manager 9.34 and
patches
Global ID

Problem

Workaround

QCCR1E105375

Service Request Catalog does not

No workaround is currently available.

Micro Focus Service Manager (9.35)
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Issues in Service Manager 9.34 and patches

Global ID

Problem

Workaround

allow approval delegation for the
Time Period module.
QCCR1E106074

When you add custom multi-text
fields to the Service Checkout
page, the fields are not displayed
correctly on the Resubmit page on
an iPad.

No workaround is currently available.

QCCR1E107572

When you use the arrow keys to
move up, down, left, and right
through cells, JAWS reads "Not in
the table" incorrectly.

No workaround is currently available.

QCCR1E107573

When you put the focus on a
column header after you switch the
mode to table layer, JAWS reads
the names of the first column
header to the column header
currently in focus incorrectly.

No workaround is currently available.

QCCR1E107712

In Internet Explorer 11, pressing F1
does not bring up the Service
Manager help information.

To work around this issue,follow these
steps:
1. Start Internet Explorer 11 from a
desktop computer, and then log in to
Service Manager.
2. Press Alt to access the menu bar in
Internet Explorer.
3. In the Tools menu, select
Compatibility View settings.
4. A dialog box appears, in which the
"Add this website:" field is
prepopulated with the host name or
IP address of your webtier host.
Click Add to add the website to the
compatibility view list.
5. Click Close. The Service Manager
web page refreshes and opens in
compatibility mode.

QCCR1E107983

In Google Chrome, you are unable
to use the Tab key to move the
focus to or off the HTML Editor.

No workaround is currently available.

QCCR1E108558

When "Virtual PC cursor" is
enabled, JAWS reads a group

No workaround is currently available.

Micro Focus Service Manager (9.35)
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Issues in Service Manager 9.34 and patches

Global ID

Problem

Workaround

name three times when you
expand the group.
QCCR1E109151

The grouping grid changes to a
paging grid when you sort a table in
the "Select a Time Period
category" page.

No workaround is currently available.

QCCR1E109390

Revisions cannot be added when
you apply PDCP4 production data
to Service Manager 9.34
applications that were upgraded
from Service Manager 9.32
applications.

No workaround is currently available.

QCCR1E109577

When you log in to the web client
by using Internet Explorer 8 for the
first time, all the characters are
displayed in an italic font.

Refresh the page in Internet Explorer.

QCCR1E110285

When JAWS 15 runs in Internet
Explorer 10 or 11, the focus does
not return to the correct radio
button when you press Shift+Tab.

No workaround is currently available.

QCCR1E105370

The Quick Jump component is not
displayed in certain screen
resolutions.

No workaround is currently available.

QCCR1E110695

The MySM details page is not
displayed in Hebrew or Arabic.

No workaround is currently available.

QCCR1E110784

Sortable column headers for
editable tables do not have a sort
icon.

No workaround is currently available.

QCCR1E110085

JAWS reads the words "read only"
when the focus is on a language
combo box.

No workaround is currently available.

QCCR1E110343

The Auto Complete function does
not work for some fields of the
timeperioddefine format.

No workaround is currently available.

QCCR1E111202

When JAWS13 is working with
Asian languages such as Chinese,
Japanese or with the Arabic
language, the "System Navigator"
and "Pagination" navigations

No workaround is currently available.

Micro Focus Service Manager (9.35)
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Issues in Service Manager 9.34 and patches

Global ID

Problem

Workaround

cannot be listed in "Landmarks."
QCCR1E111084

You cannot use the keyboard to
operate on a List Builder control
when JAWS is running.

No workaround is currently available.

QCCR1E109267

The Label of the Parent Record
field cannot be displayed correctly
when saving an incident record.

No workaround is currently available.

QCCR1E110722

Accessibility to the Time period
rules table and the Time period
occurrences table is not good on a
time period record detail form.

No workaround is currently available.

QCCR1E112188

If a Comfill field has Auto
Complete enabled and a data
change event (not 0) defined, and a
post expression/post JavaScript is
defined for the link for this field, the
data change event may not work.

Do not enable Auto Complete for the
Comfill field.

QCCR1E111326

Cannot open timeperiod and entry
records in Embedded Calendar in
Internet Explorer 11.

Use an older version of Internet Explorer
or use a different browser such as
Firefox or Chrome.

QCCR1E111994

The Timeperiod Manager cannot
see the Approval Definition
menu when the system has no
Process Designer content pack
applied.

To work around this issue,follow these
steps:
1. Log in to Service Manager Windows
client as a system administrator.
2. Type menu in Service Manager
Command line, and then press
Enter.
3. Type timeperiod in the Menu
Name field, and then click Search.
4. Locate the row with the description
of Approval Definitions.
5. Remove and jscall
("security.hasRight", "Common
Configuration","view")=true"
from the Condition field.

QCCR1E112097

The Option menu is overlapped by
full calendar in the Service
Manager accessible web client.

Micro Focus Service Manager (9.35)
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Issues in Service Manager 9.33 and patches

Global ID

Problem

Workaround

QCCR1E111131

Calendar and Timeperiod in the
Module drop-down list are not
translated in the Security Area
Search page. To see this issue,
follow these steps:

No workaround is currently available.

1. Log in to the web client with a
non-English language.
2. Go to System Administration
> Security > Security Area.
3. Click the "Module" drop-down
list.
QCCR1E119985

When you are updating an Incident, Correct the invalid input before you click
if you input an invalid date time
the Cancel button.
value to the Outage Start or the
Outage End field, you cannot
close this incident tab by clicking
the Cancel button. The same
problem also happens when you
are opening a new Incident,
opening a new Change, or updating
an existing Change.

QCCR1E120076

On the wizard page of Approval
Delegation > Set Delegate, when
you input an invalid date time value
to the Valid From or the Valid To
field, the value will be cleared after
you click the Next button.

No workaround is currently available.

Issues in Service Manager 9.33 and
patches
Global ID

Problem

Workaround

QCCR1E100136

After the installation of a language
pack, the Windows client, if running
on an Arabic Windows 2008, displays
the tooltips of the 'Added' and
'Forced'/'Updated' columns in the
content pack results as reversed.

No workaround is currently
available.
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Issues in Service Manager 9.32 and patches

Global ID

Problem

Workaround

QCCR1E101782

In Trusted Sign-On (TSO) mode, if
users log in to the web client with
Simplified Chinese in Internet
Explorer 10 running on Windows 8 or
Windows 2012, the web client still
displays in English instead of in
Simplified Chinese.

No workaround is currently
available.

QCCR1E103847

An arrow connector in a Process
Designer workflow might be
misaligned when the destination
phase is vertically too close to
another phase (this problem was
introduced in Service Manager 9.33
patch 1 revision 1).

To resolve the issue, move the
destination phase away enough from
the adjacent phase.

QCCR1E103858

It displays auto-open tasks in the task
planner window (this problem was
introduced in Service Manager 9.33
patch 1 revision 1).

No workaround is currently
available.

Issues in Service Manager 9.32 and
patches
Service Manager Issues
Global ID

Problem

Workaround

QCCR1E64377 In the web client, when a Configuration
Item (CI) record is opened, the CI label
does not show (or only shows for the
first time) in the CI Visualization
(Relationship Graph). This issue occurs
only when JRE 6 is used.

As Oracle has fixed this Applet issue,
JRE 6 customers need to upgrade their
JRE to the latest JRE6 or JRE7 on the
machine that runs Internet Explorer or
Firefox in order for CI Visualization to
display CI labels correctly.

QCCR1E95725 Due to a known issue in JDK (bug
id:7196513), CI icons are not displayed
correctly in Firefox when Httponly
cookies are enabled in the web
application server.

When Httponly cookies are enabled,
users can only use Internet Explorer 7 or
higher for CI icons to display correctly.
As Oracle has fixed the Httponly cookie
issue as of JDK 7u6, users need to
install the latest 32-bit JRE (7u6 or
above) on the machine that runs Internet
Explorer 7 or higher.
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Global ID

Problem

Workaround
Note: In Service Manager 9.33,
users can only use Internet
Explorer 8 or higher for CI icons to
display correctly.

QCCR1E95963 An error occurs when loading a dbdict
twice in an unload file. The two dbdict
records have the same name, but
different key types: the first one has
unique key, while the second's key
type is primary key.

Do not export to an unload file a dbdict
record whose key type has changed.

QCCR1E97260 When SSL is enabled between the web
application server and Firefox, a
ClassNot found Exception error
displays in the workflow section of the
Change form. This issue does not
occur in IE or in Firefox without SSL
enabled.

There are two workarounds:
l

l

Use Internet Explorer instead of
Firefox.
If using Firefox, import the client
certificate into the Java console on
the end user's machine. Here are the
steps for Windows 7:
a. Open Control Panel, and i n the
Control Panel Search box enter
"Java Control Panel".
b. Double-click the Java console
icon to open the Java console.
c. On the Security tab, click
Manage Certificates ....
d. On the Certificates window,
select certificate type: Client
Authentication, and click
Import.
e. Follow the wizard and import the
client user's certificate.

QCCR1E97492 Clicking the Back button on the CI
Visualization page (which opens when
you click More > Expand CI
Visualization in a CI record) causes a
Firefox crash.

No workaround is currently available.

QCCR1E97603 If a format that contains a button with
Enable condition is created or modified
by using a Service Manager 9.31 patch
1 server, when using it in Service

Upgrade both of the Service Manager
server and client to the same patch
level: Service Manager 9.31 patch 1 or
later.
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Global ID

Problem

Workaround

Manager 9.31 GA or earlier, the client
crashes. However, formats created by
using the Service Manager 9.31 GA or
earlier server work fine.
QCCR1E94657 When PDCP4 is applied, the first group
on the form is not shown in the Jump
Address drop down list.

Move the scroll bar to the top-most
position and then you will see the first
group.

QCCR1E97856 In a single-line text field, some special
No workaround is currently available.
characters whose HTML code is
&#x...; (where ... stands for a hex
number) are not represented as their
original format. Instead, they display as
&#x...;. However, such characters
are represented as the original format in
other widgets (textarea, label, message
panel, and so on).
QCCR1E93604 The HTTP Response Code is 200
instead of 400 when a RESTful request
uses an invalid sort field separator (for
example, a plus symbol).

Use a valid sort field separator.

QCCR1E94204 Because of the incorrect status, the
operation could not proceed after
merging a record.

Reset the status of this record (for
example, reopen the closed record) and
perform the last operation again.

QCCR1E94206 The last operation could not be
repeated after merging a record
because the button for the last
operation disappears.

Reset the condition for the button in this
record, for example, Reopen the closed
record, and perform the last operation
again.

QCCR1E96353 RESTful API: An incident record is
successfully resolved when posting an
incident resolve action with a blank
"ClosureCode" and "Solution".

Validation is not performed for the fields.

QCCR1E96391 Restful API: Results are in the wrong
order when sorted by an array field.

No workaround is currently available.

To work around this issue, validate
them at the RESTful client side, or
manually add validation for the fields to
the format control.

This issue occurs because the Service
Manager RTE does not support sorting
by array fields. A list is returned without
any error message.
QCCR1E97898 Restful API: A 400 Bad Request error
occurs when a RESTful API request is
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Global ID

Problem

Workaround

a cross-table join query.

native queries.
Currently RESTful API framework does
not support cross-table SQL queries.

QCCR1E98320 When a record is removed after being
read, the Merge function still allows the
user to merge the record and the user's
input is lost.

No workaround is currently available.

QCCR1E98227 In Approval Delegation wizard, go to
another page (do not change the
delegation module) after choose the
operator to delegate in "Select Approval
Groups" page, then back to "Select
Approval Groups" page again. You will
find a blank line is displayed in the right
table, instead of the operator record.

This is only a display issue, and will not
impact the functionality. If you need to
remove the operator from the delegation
list, choose the blank line, and then
click the remove icon; otherwise the
operator will be successfully delegated
once you save the update.

QCCR1E98576 When there are conflicted updates on
system fields, the system displays the
message "The conflicted fields cannot
be merged. Reload the record.",
whereas the Merge button is available.
Actually, the merge function should not
be available in such case.

Ignore the Merge button. Reload the
latest record to edit this record again.

QCCR1E98398 When you are updating a record and
adding attachments to this record, if
your updates conflict with another
users' updates or the updates of a
background process, the attachments
will be lost after either automatic or
manual merge.

After automatic or manual merge, add
the attachments again before saving the
merged result of the record.

QCCR1E98411 SRC failed to retrieve service catalog
items from Service Manager on
upgrade from Service Manager 7.11 to
Service Manager 9.32.

In the svcCatalog dbdict, the id.attach
field is character type, which should be
number type. The id.attach field is an
alias of the id field in the svcCatalog
table.
To fix the issue, change the field type
using the Dbdict Utility.

QCCR1E98618 Subcategory data on the Incident form
is not available after upgrading from
ServiceCenter 6.2 to Service Manager
9.32.

If necessary, manually add the
subcategory data.
1. Enter db in the Service Manager
command line box.

Subcategory data is not upgraded.
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Global ID

Problem

Workaround
2. In the Table field, enter
subcategory, and click Search.
3. For each Catagory in the dropdown
list, add the following Areas (enter a
value in the Area field and click
Add): access, data, failure,
hardware, performance, and
security.

QCCR1E98475 With Process Designer Content Pack
9.30.3 applied, the Merge functionality
does not work when a user clicks Save
& New in an interaction record opened
through a search.
1. Open an interaction through a
search.
2. Update the Title.
3. Another back-end process has
updated the Title to another value.

If you encounter the error "This record
has changed since you selected it."
when clicking the Save & New button
on an interaction opened through a
search, to avoid abandoning your
updates, do not use the Save & New
button to save your updates; instead,
first click the Save button to save your
updates with the merged result, and
then register a new interaction from the
navigation menu.

4. Click Save & New. An error
occurs: This record has
changed since you selected
it.
You cannot perform Merge for the
conflicted updates as expected.
Service Request Catalog Issues
Global ID

Problem

Workaround

QCCR1E90074

When entering a search string in
Service Request Catalog, autocomplete does not work if the
browser's preferred language is set
to an East Asian language (for
example, Simplified Chinese).

No workaround is currently available.

QCCR1E98339

Custom fields do not load the
DEFAULT company value when the
checkout panel is empty for one of
the three checkout panels of your
company.

After upgrade, you should manually
add the same structure configuration
of the DEFAULT company for the
empty checkout panel of your
company. For example, before
upgrade, you, as an SRC
administrator, only defined custom
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Global ID

Problem

Workaround
fields for the Service Catalog
checkout panel for your company.
After upgrade to Service Manager
9.32, if you want to use the support
checkout panel and generic support
checkout panel in SRC correctly, you
need to manually add OOB
configurations for the Support Catalog
and Generic Support checkout
panels, which you can copy from
those panels of the DEFAULT
company.

Issues in Service Manager 9.31 and
patches
Global ID

Problem

Workaround

QCCR1E63663

The Service Manager client loses
connectivity during JavaScript
execution of the file.list RAD
application.

No workaround available.

When Service Manager is running
on Unix, the legacy listener may
log intermittent signal 11 errors
upon CIT initial connectivity test if
exec-shield is not set properly.

Use one of the following solutions to work
around this issue.

QCCR1E57385

Created a knowledge article (KM1166532),
which states that Service Manager does
not currently support calls from JavaScript
on RAD applications that use the rio/fdisp
panels.

Solution 1:
Connect Connect-It to the Web Services
connector instead of the Legacy Listener
connector.
Solution 2:
Before connecting Connect-It to the
Legacy Listener connector, do the
following:
1. Add usethreading:0 in the sc.ini file,
which is located in <Service Manager
server installation
path>\LegacyIntegration\RUN.
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Global ID

Problem

Workaround
Note: For 64-bit RedHat Linux
servers only, you can alternatively
run the following shell commands
as root:
# sysctl -w kernel.exec-shield=0
# sysctl -w kernel.randomize_
va_space=0
2. Start the legacy listener.

QCCR1E67491

When the collation of the db
instance is Chinese_PRC_BIN,
Web service clients fail to connect
to Service Manager. Only ASCII
operator names are supported, so
only ASCII operator names can be
used.

Note: This issue only exists in Web
service integrations. Therefore, the
Service Manager clients do not have
this problem.
When Service Manager is handling an
incoming SOAP request, the authorization
string is decoded by BASE64Decoder.
Service Manager uses the decoded string
value to construct a UTF-8 string that is
used in the RTE. However, the
authorization string is in the header and
Service Manager does not know the
charset or encoding of the underling string
value, which is BASE64 encoded.
Therefore, if the underlying string value is
not UTF-8, this problem will occur. In
Service Manager, when fetching an
operator record from the database, no
matter what collation the database uses,
the operator record finally will get a UTF-8
operator value. However, even if users put
the same value in the authorization header,
the operator name may differ because of
the charset/encoding issue. Because of
this, the operator will fail to log on.
This is a limitation of Service Manager. Do
not use non-ASCII characters in operator
names. Created a knowledge article
(KM1442479) to document this limitation.

QCCR1E75182

HTML email truncates the body of
the message and sends the HTML
code without translating it.
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Global ID

Problem

Workaround
Make sure your HTML email templates do
not exceed this size limit.

QCCR1E77563

Signal 11 error is received when
calling the toXMLString() routine of
the Users object.

No workaround is currently available.

QCCR1E88222

An unload file that is exported from
an Oracle to an SQL Server
database fails to import when the
unload file already contains a
RECORD_KEY field and the
length of first unique key exceeds
the db limitation.

This request is caused by the product
running in an unsupported configuration.
Change to a documented and supported
configuration. If the problem still exists in a
supported environment, contact HP
Support.
To work around this issue, do not use
"RECORD_KEY" as a SQL Name for a
field in dbdict. This field name is reserved
by Service Manager. To do this, follow
these steps:
1. Enter dbdict in the Service Manager
command line box, and then press
Enter.
2. Open the problematic dbdict which has
the "record.key" field defined.
3. Select the "record.key" field, and then
change the SQL Name from
"RECORD_KEY" to anything else.

QCCR1E74808

After clicking the Cancel button in
the Condition Editor from the
Workflow Editor, the current tab
sometimes becomes a blank
screen and the tab cannot be
closed.

QCCR1E105052 In Task Planner, the tooltip of a
task displays the change phases
with their names instead of their
display names.
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Installation notes
This section provides instructions on installing each component in this patch release. You can also
refer to the Service Manager 9.35 Installation and Upgrade Documentation Center, which is available to
download from the following Software Support Online (SSO) website:
https://softwaresupport.softwaregrp.com/km/KM01294561
Before you proceed, we recommend that you consult the latest Service Manager 9.35 Support Matrix
and the Compatibility Matrix for Service Manager Applications Content. These are available at the
following website:
https://softwaresupport.softwaregrp.com/group/softwaresupport/support-matrices

Backup and backout instructions
In case you need to restore your Service Manager system to its original state after installing the
component patches in this release, make necessary backups before each patch installation. If a
rollback is needed, follow the backout instructions.

Server
Backup
Before you apply the server patch, make a backup of the server installation folder. For example,
C:\Program Files\HP\Service Manager 9.35\Server.
Note: If you have a horizontally scaled system, be sure to back up the server installation folder for
each server instance.

Backout
Service Manager has supported FIPS mode since version 9.32. To run Service Manager in FIPS mode,
you must upgrade your database to the 256-bit AES encryption algorithm. Once you change all of the
encrypted fields to use the new 32 character encryption, you cannot roll back the RTE and still read the
encrypted data.
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After installing the patch, do the following to back out:
1. Stop the Service Manager server.
2. Remove the existing server installation folder.
3. Copy the backup folder back.
Note: Make sure that the embedded Tomcat is also replaced with the backup, because the
version of the embedded Tomcat may have dependency on a specific server version.
Note: If you have a horizontally scaled system, make sure that every server instance is
replaced with its backup.
4. If you have also loaded platform unload files required for your server changes, you must also roll
back the application changes made by the unload files. See "Applications" on page 31.
5. For Unix-based platforms other than Linux, make a backup of your JRE if you have not yet
upgraded to JRE 7 or JRE 8.
6. Restart the Service Manager server.

Web tier
Backup
Before deploying the new web tier, make a backup of the following items:
l

web.xml

l

application-context.xml

l

log4j.properties

l

the folder specified in the customize-folder web client parameter

l

splash screen

l

style sheets

l

<webtier>\images\obj16\ folder

l

any other customizations you made, including your webtier-<version>.war (webtier-ear<version>.ear) file.
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Backout
To roll back to the old web tier, follow these steps:
1. Delete or uninstall the existing web tier.
2. Clear the cache of your web application server (for example, Tomcat).
3. Redeploy the old web tier.
4. Restore your old customizations.

Windows client
Backup
To back up the Windows client, follow these steps:
1. Make a backup of your Windows client home folder, for example,
C:\Users\<username>\ServiceManager. Your connections and personalized settings are stored in
this folder.
Note: This is the out-of-box home directory, and could differ from yours if you made changes
to <Client>\configuration\config.ini file. If so, back up the files from the location
specified in that file.
2. Make a backup of your certificate configuration files if any (Window > Preferences > HP Service
Manager > Security). For example, your CA certificates file and client keystore file.
Note: For version 9.34.p2 or later, make a backup of the keystore password preference file:
<workspace_dir>\.metadata\.plugins\org.eclipse.core.runtime\.settings\
com.hp.ov.sm.client.eclipse.base.prefs
3. Make a backup of the following folder if you have added or modified any icons:
<Client>\plugins\com.hp.ov.sm.client.eclipse.user_
<version>\src\resources\icons\obj16\.

Backout
To roll back to the old Windows client, follow these steps:
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1. Uninstall the new Windows client.
2. Reinstall the previous Windows client.
3. Restore your old Windows connections and configurations.

Applications
If you plan to upgrade your applications to this release level, make a backup of your database before
the upgrade, in case you need to restore your database after the upgrade. Creating a backup of the
entire database and restoring the database if needed is a better approach for a full applications upgrade.
If you plan to load individual unload files in this release, follow the backup and backout instructions
below.

Backup
Tip: If your application version is 7.11 ap3, 9.21 ap3, 9.30 ap3, 9.31 or later, you are
recommended to use Unload Manager to make a backup of the files to be modified by an unload
file, because Unload Manager can create a backup of your old data during the installation of the
unload; if your application version is other than any of these, Unload Manager is not available and
you can use Database Manager instead.
To use Unload Manager to make a backup, follow these steps:
1. Go to System Administration > Ongoing Maintenance > Unload Manager.
2. Double-click Apply Unload. A wizard opens.
3. Select the unload file you want to apply, also specify a backup file, and then click Next. Details of
the unload file appear.
4. Double-click a conflicting object in the table to open the merge tool:
a. Merge the object, and then select the Reconciled check box.
b. Click Save to go back to the wizard.
5. Click Next after all the conflicting objects are reconciled.
6. Click Yes on the confirmation window to apply the unload.
7. Click Finish.
Now, the unload has been applied and at the same time your old data backed up.
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To use Database Manager to make a backup, follow these steps:
1. Go to Database Manager, select Import/Load from More or the More Actions menu, and browse
to the unload file.
2. Click List Contents on the menu bar, to view a list of files that have been updated in this unload.
See the following figure for an example.

This figure shows the contents of an unload file that contains changes to the following files:
File

Record

Process

svc.add.cart

application

money.format
Note: The scmessage records listed under each RAD application are
messages used in this RAD application; no backup is needed for them.

ScriptLibrary

svcCartHelper

datadict

activity

dbdict

activity
Note: The “activity” file with no records actually represents the dbdict
record of the activity file.

scmessage

The record whose message class is “fc” and message number is 1000.
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3. Go to Database Manager, in the Table field enter a file name you got in step 2, and click the
Search button.
4. If the format selection page shows, select the proper format by double-clicking it (for example,
select the device format for the device file), and then search for the file record.
5. Click More (or the More Actions menu) > Export/Unload after the file record displays.
Note: If Export/Unload is not available, check the Administration Mode check box in
Database Manager and try again.
6. In the pop-up window, specify your backup upload file path/name, and click Unload Appl.
Caution: Make sure that Append to file is selected.
7. Continue to follow steps 3 through step 6 to back up the rest of the files you got in step 2.

Backout
Tip: You can use Unload Manager (recommended) or Database Manager (if Unload Manager is
not available in your application version) to roll back to your old data, as described in the following.
To roll back to your old data using Unload Manager, follow these steps:
1. Go to System Administration > Ongoing Maintenance > Unload Manager.
2. Double-click Apply Unload. A wizard opens.
3. Select the unload file generated in the backup process, specify a backup file, and then click Next.
Details of the unload file display.
4. Double-click a conflicting object in the table to open the merge tool:
a. Merge the object, and then select the Reconciled check box.
b. Click Save to return to the wizard.
5. Click Next after all the conflicting objects are reconciled.
6. Click Yes on the confirmation window to apply the backup unload.
7. Click Finish.
To roll back to your old data using Database Manager, follow these steps:
1. Go to Database Manager, click More > Import/Load.
2. Browse to the backup unload file you created.
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3. Click Load FG.

SRC
Backup
Make a backup of the entire SRC installation folder.

Backout
Remove the new SRC installation folder and copy the SRC installation backup folder back to the web
application server.

Knowledge Management search engine
To back out your Knowledge Management (KM) search engine changes, make a backup before your
KM patch installation.
Note: Keep in mind that you also need to roll back KM-related server side and application side
changes. For details, see the Server and Application backup and backout instructions.

Backup
Before applying the KM patch and upgrading the KM embedded Tomcat, do the following:
1. Make a backup of the search engine installation folder. For example, C:\Program
Files\HP\Service Manager 9.30\Search Engine Backup.
2. Make a backup of the files to be modified by the unload files in the KM patch.
3. Make a backup of your schemastub.xml file under the <SM server>/RUN/km/styles/ directory .

Backout
After installing the patch, follow these steps to backout:
1. Stop your KM search engine.
2. Remove the existing search engine installation folder.
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3. Copy the backup folder back.
4. Be sure to roll back KM related changes on the Service Manager server and application sides,
including the kmsolr unloads files and the server's schemastub.xml file.
5. Restart your KM search engine.
6. Perform a full re-index on all of your knowledgebases.

Digital signature notice
We sign Windows executable files with a digital signature. Since January 2012, this process has been
updated to use a new VeriSign root certificate. On a Windows system that does not have the new
VeriSign root or intermediate certificate installed, when the user right-clicks the file and then goes to
Properties > Digital Signatures > Details, the following verification error is displayed:
The certificate in this signature cannot be verified.

To resolve this issue, either enable Windows Update or download and install the G5 Root certificate as
documented at: https://knowledge.verisign.com/support/ssl-certificatessupport/index?page=content&actp=CROSSLINK&id=SO19140.
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Server update installation
The server update for your operating system consists of a compressed file, sm9.35.6007-P6_<OS>.zip
(or .tar), which contains updated files of the Service Manager server. These files add to or replace the
files in the [SM Server Root]\([SM Server Root]/)RUN, irlang, bin, legacyintegration, and platform_
unloads directories.
Note: If you use an Oracle RDBMS, be aware that Oracle Call Interface (OCI) 11.2.0.3 is
required. For more information, see the latest Service Manager 9.35 Support Matrix at this website:
https://softwaresupport.softwaregrp.com/group/softwaresupport/support-matrices

Built-in troubleshooting tool (SM Doctor)
Additionally, as of Service Manager 9.32, the server patch includes an installation of the Service
Manager Doctor (SM Doctor) tool. The server patch will install the tool in the <SM server root>\(<SM
server root>/)smdoctor directory. For information on how to use this tool, see the Guides and reference
> Troubleshooting > HP Service Manager Doctor section in the Help Center.

Upgrade paths
This server patch must be applied on top of an earlier Service Manager 9.3x system.
The following server upgrade paths are recommended:
l

New customers: Install the Service Manager 9.30 GA server, and then directly apply this server
patch.

l

Existing SC6.2, Service Manager 7.11 and 9.21 customers: Uninstall the old server, install the
Service Manager 9.30 GA server, and then apply this server patch.

l

Existing Service Manager 9.3x customers: Apply this server patch.

For installation instructions of the Service Manager 9.35 server, see the Service Manager 9.35
Installation and Upgrade Documentation Center, which is available to download from the following
Software Support Online (SSO) website:
https://softwaresupport.softwaregrp.com/km/KM01294561
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Compatibility mode for installation on
Windows Server 2012
As of Service Manager 9.32, Windows Server 2012 is supported. Be aware that compatibility mode is
required for installing the Service Manager 9.30 GA server on Windows Server 2012 (not required for
Windows Server 2008). To run your server installation in compatibility mode, perform the following
steps:
1. Right–click the server's setupwin32.exe file icon.
2. Click Properties > Compatibility.
3. Click Run this program in compatibility mode for, and then select Windows Vista (Service
Pack 2).
4. Click Apply, and then click OK.
5. Run the setupwin32.exe file to complete the installation.
When you uninstall your server on Windows Server 2012, you should also use compatibility mode. To
do this, set your Windows server uninstaller file (_uninst\uninstaller.exe) to compatibility mode as
described above, and then uninstall the server using the uninstaller or Control Panel.

Server patch installation steps
Caution:
l

The server patch will upgrade your embedded Tomcat to version 6.0.53, and therefore requires
additional steps.

l

The server patch will upgrade your JGroups (in the RUN/lib directory) to version 3.2.

l

For Windows and Linux, the server's embedded JRE has already upgraded to version 8; for
other Unix-based platforms, you need to manually perform this JRE upgrade.
The JRE upgrade will cause external web service calls over SSL to fail if the remote endpoint
does not support Server Name Indication (SNI), which is by default activated in JRE 7 and
JRE 8. Once Service Manager is upgraded to use JRE 7 or JRE 8, it starts to use SNI
extensions during the SSL handshake. If the remote endpoint does not support SNI, the web
service call will fail with an error message. To solve this issue, do either of the following:
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o

Activate SNI at the remote end point (recommended)

o

If the remote endpoint does not support SNI extensions, and SNI cannot be activated, add
the following JVMOption<n> parameter either to the sm.ini file, or to the start command of
the servlet(s) in the sm.cfg file:
JVMOption2:-Djsse.enableSNIExtension=false

Note: If you have a horizontally-scaled system, you must upgrade all your server instances.
To install the new sever patch, follow these steps:
1. Stop all Service Manager clients.
2. Stop the Service Manager server.
3. Make a backup of the Server installation directory. See also "Backup and backout instructions" on
page 28.
4. Delete the RUN/tomcat directory. Tomcat in this directory will be upgraded to a higher version
after the server patch is installed.
5. Delete the RUN/lib directory.
6. For Windows and Linux platforms, delete the RUN/jre directory.
Note: This is to avoid conflicts between the old JRE and new JRE.
7. Extract the compressed files for your operating system into the main Service Manager directory on
the server.
Note: Two packages are provided for HP-UX. Use sm9.35.6007-P6_HPUX-IA64ORCL12C.tar only when an Oracle 12c database is used, and use sm9.35.6007-P6_HPUXIA64.tar in other cases.
8. For UNIX servers, set the file permissions for all Service Manager files to "755."
9. For the following Unix servers, manually upgrade to one of the following JRE versions, if you have
not already done so.
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a. Install an appropriate version of JRE for your platform.
Solaris

JRE 7 (update 80 or greater)

HPUX

JRE 7 (JRE_7.0.12 or greater) or JRE 8 (JRE_8.0.07 or greater)

AIX

JRE 7 (SR8 or greater) or JRE 8 (SR3FP10 or greater)
Tip: You can check the JRE version on AIX by running the $<JRE_
INSTALL_DIR>/bin/java -version command, in which <JRE_INSTALL_
DIR> is the JRE installation directory. If you are working with JRE 8, make
sure that the system outputs consist of the following line:
Java(TM) SE Runtime Environment (build pap3280sr3fp10-20160720_
02(SR3fp10))

b. Set your JAVA_HOME environment variable to point to the correct JDK (if you have JDK
installed) or JRE (if you have only JRE installed).
c. Execute \RUN\removeLinks.sh to remove the old symbolic links and then execute
\RUN\setupLinks.sh to create new symbolic links.
d. Run the following command to check that the JRE version is correct:
RUN\jre\bin\java –version
10. If you have made any customizations/changes to the original RUN/tomcat folder, restore them in
the new RUN/tomcat folder.
11. Your old schemastub.xml file (in the <SM_Server_Home>\RUN\km\styles\ directory) has been
updated to a newer version. Either keep your old file by copying it back or keep the updated
version (a full reindex for the knowledgebases is then required).
12. Run the sm -unlockdatabase command.
Note: This step is required the first time you upgrade to 9.30p4 or later; it is also required
whenever you change the server’s IP address after your upgrade to 9.30p4 or later. The
purpose of this step is to prevent stale license information from being kept in the system. In a
scaling implementation, you can run this command from any one of your servers.
13. Restart the Service Manager server.
14. Restart the Service Manager clients.
15. Verify the version using either of the methods:
o

From the Windows client, click Help > About Service Manager Server. The server version
should be:
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Release 9.35.6007 build P6
o

From the server's RUN folder, run the sm -version command. The server version should be:
Version: 9.35.6007
Patch level: P6

Server application unload installation
If a platform fix (in most cases, a server fix) also requires an applications change to resolve the relevant
issue, an unload file is provided. Unload files introduced in earlier patches are also included in this
cumulative release. If you have not already applied them for a previous patch, you should also apply the
unload files that are intended for your applications version. For more details about these applications
updates, see the Release Notes for those patches.
This patch release includes the unload files that come with the server update. When you extract
sm9.35.6007-P6_<OS>.zip (or .tar), it will add the files to the following directory:
[SM Server Root]\platform_unloads ([SM Server Root]/platform_unloads)
Note: Unload files should be installed in their patch order. That is, those introduced in patch 1
should be applied first, then those introduced in patch 2, and so on. However, unload files
introduced in the same patch can be installed in a random order, unless otherwise specified.
Unload file naming convention
The unload files use the following naming convention: <CR_ID>_SMxxxPxx_SMxxx.unl, where:
l

<CR_ID>: The identification number of the applications defect that the unload file fixes. For
example, QCCR1E12345.

l

SMxxxPxx: The minimum Service Manager patch level that requires the unload file. For example,
SM921P2, which means the unload file comes with the server updates in Service Manager 9.21
patch 2 and should be used for patch 2 or higher.
Note: Sometimes this portion contains an additional hot fix number, for example,
SM711P16HF8. This example means the unload file is intended for Service Manager 7.11
patch 16 Hot Fix 8 or higher.

l

SMxxx: The Service Manager applications version that requires the unload file. For example,
SM711, which means the unload file is intended only for Service Manager applications version 7.11.
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Note: If the applications version suffix is omitted, the unload file is then intended for all
applications versions compatible with the server version, unless otherwise specified. For
example, QCCR1Exxxx_SM930P4.unl is normally intended for applications versions 7.11,
9.2x, and 9.3x (which are compatible with Service Manager server 9.30), unless otherwise
specified in the unload file description. For information on the applicable applications versions
for each unload file included in the current patch, see Unload Files Included in the Current
Patch.
Unload files included in the current patch
The following are unload files included in the current patch release.
Introduced
in 9.3x
patch

Used for
apps
version(s)

QCCR1E108399_
SM935P6_
SM930.unl

9.35p6

9.30
through
9.34

Optimizes the inbox query to improve the
system performance.

QCCR1E128328_
SM935P6_
SM9.30.unl

9.35p6

9.30
through
9.34

Enables the HTML whitelist feature by default.

QCCR1E118520_
SM935P3_
SM711.unl

9.35p3

7.11

Fixes this issue: The query hash algorithm is
weak and the salt is hard-coded.

QCCR1E118520_
SM935P3_
SM921.unl

9.35p3

QCCR1E118520_
SM935P3_
SM930.unl

9.35p3

QCCR1E103456_
SM934_SM932.unl

9.34

Unload file

Description

Associated server fix: QCCR1E108399

Associated server fix: QCCR1E128328

Associated server fix: QCCR1E118520
9.21

Fixes this issue: The query hash algorithm is
weak and the salt is hard-coded.
Associated server fix: QCCR1E118520

9.30
through
9.34

Fixes this issue: The query hash algorithm is
weak and the salt is hard-coded.

9.32

Fixes this issue: When you use the "Any of
these words" text search option to export
records to Excel or to a text file, some records
are not exported.

Associated server fix: QCCR1E118520

Associated server fix: QCCR1E103456
QCCR1E106292_
SM934.unl

9.34
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Unload file

Introduced
in 9.3x
patch

Used for
apps
version(s)

Description
the globalist or locallist file is large.
Associated server fix: QCCR1E106292

QCCR1E112815_
SM934P1_
SM934.unl

9.34p1

9.34

Fixes this issue: The Time Period Management
menu and sub-menus are not displayed after
upgrading to Service Manager 9.34.
Associated server fix: QCCR1E112815

QCCR1E114378_
SM934P2_
SM932.unl

9.34p2

9.32

Fixes this issue: The Auto complete feature
needs RTE to change the line value of
cursor.line to the value of the line when calling
cursor.field.name.set.
Associated server fix: QCCR1E114378

QCCR1E99147_
SM933_SM930.unl

9.33

9.30, 9.31,
and 9.32

Fixes this issue: The first tab of a Notebook is
reset to be the active tab when a new interaction
is opened through the "Return to blank
interaction" environment settings.
Associated server fix: QCCR1E99147

QCCR1E99398_
SM932P2.unl

9.32p2

7.11, 9.21,
9.30, and
9.31

Enables the inactivity timer function to work
correctly when the version of applications is
lower than the version of the server.
Associated server fix: QCCR1E99398

QCCR1E31324_
SM932.unl

9.32

7.11, 9.21,
9.30 and
9.31

Fixes this issue: With Syslog audit turned on,
only a syslog record showing login is created; no
record for logoff is recorded if the user does not
log out "normally."
Associated server fix: QCCR1E31324

QCCR1E96802_
SM931P3.unl

9.31p3

7.11, 9.21,
9.30, and
9.31

Changes the behavior when handling web
service request user passwords. See the
Service Manager 9.31p3 Release Notes.
Associated server fix: QCCR1E96802

QCCR1E52767_
SM931P3_
SM930.unl

9.31p3

9.30

Fixes this issue: Users cannot add data policy
definitions on joined tables.
Note: You do not need to load this unload if
you are running on Service Manager 9.31,
9.21, or 7.11 applications.
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Unload file

Introduced
in 9.3x
patch

Used for
apps
version(s)

Description
Associated server fix: QCCR1E52767

QCCR1E76724_
SM931P2_
SM930.unl

9.31p2

9.30 and
9.31

Fixes this issue: After deleting the unique key of
cm3r, a signal 11 happened while doing an IR
regeneration.
Associated server fix: QCCR1E76724

QCCR1E76227_
SM930P6_
SM930.unl

9.30p6

9.30

Contains the code changes to support
localization of incident/change priority and
urgency strings for the 9.31 Mobile Applications
Client.
Note: Not needed for the Service Manager
9.32 or later Mobile Applications client.

QCCR1E78794_
SM930P6_
SM930.unl

9.30p6

9.30

Removes incident.assignee when a Web
Service call specifies the assignee as 'NULL'
through the Service Manager9.31 Mobile
Applications Client.
Note: Not needed for the Service Manager
9.32 or later Mobile Applications client.

QCCR1E76796_
SM930P6_
SM930.unl

9.30p6

9.30

Provides the ability to turn on debugging
dynamically for user sessions or schedulers.
Note: This unload requires the Service
Manager 9.31 server.

QCCR1E71099_
SM930P5_
SM711.unl

9.30p5

7.11

Displays Value Lists instead of the data directly
retrieved from the database in a QBE list when
adding a field by using Modify Columns.
Associated server fix: QCCR1E71099

QCCR1E71099_
SM930P5_
SM920.unl

9.30p5

9.20

Displays Value Lists instead of the data directly
retrieved from the database in a QBE list when
adding a field by using Modify Columns.
Associated server fix: QCCR1E71099

QCCR1E71099_
SM930P5_
SM930.unl

9.30p5

9.30

Displays Value Lists instead of the data directly
retrieved from the database in a QBE list when
adding a field by using Modify Columns.
Associated server fix: QCCR1E71099
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Introduced
in 9.3x
patch

Used for
apps
version(s)

QCCR1E71139_
SM930P5_
SM930.unl

9.30p5

9.30

Works with server fix QCCR1E71139 to solve
this issue: When Service Manager is configured
to use LDAP as the authentication data source,
the user is still forced to change the password if
the user is expired in the local database.

QCCR1E31941_
SM930P4_
SM930.unl

9.30p4

9.30

Enables users to use a pre-configured decimal
symbol when completing numeric fields.

Unload file

Description

Note: This enhancement requires a 9.30p4
or later server; however if you are using
RTE version 9.30 with applications version
7.11 or 9.20, do not load this unload file; you
can safely upgrade your server to 9.30p4 or
later without applying this applications
change.
Associated server fix: QCCR1E31941.
QCCR1E73452_
SM930P4.unl

9.30p4

7.11 trough
9.30

Enables Mandanten restricting queries to be
updated correctly after a profile is edited.
Associated server fix: QCCR1E71897

QCCR1E67072_
SM930P4_
SM930.unl

9.30p4

7.11 and
9.20

Enables users to take advantage of the new
KMStatusListener background process.
Note: This unload file is not needed for
applications version 9.30 or later, which
supports only the Solr Search Engine.
Associated server fix: QCCR1E67071

QCCR1E70163_
SM930P4_
SM711.unl

9.30p4

QCCR1E70163_
SM930P4_
SM920.unl

9.30p4

QCCR1E70163_
SM930P4_
SM930.unl

9.30p4

QCCR1E67647_

9.30p3

7.11

Fixes this issue: The KMUpdate process
terminates abnormally.
Associated server fix: QCCR1E69687

9.20

Fixes this issue: The KMUpdate process
terminates abnormally.
Associated server fix: QCCR1E69687

9.30

Fixes this issue: The KMUpdate process
terminates abnormally.
Associated server fix: QCCR1E69687
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Unload file

Introduced
in 9.3x
patch

SM930P3.unl

Used for
apps
version(s)
through
9.30

Description
the request response when closing an
interaction by calling CloseInteraction from a
web service without specifying the localSolution
field in the request.
Associated server fix: QCCR1E54192

QCCR1E67610_
SM930P2.unl

9.30p2

7.11
through
9.30

Enables you to block potentially dangerous
attachments.
Associated server fix: QCCR1E64290

Loading unload files
Tip: If your application version is 7.11 ap3, 9.21 ap3, 9.30 ap3, 9.31 or later, you are
recommended to use Unload Manager to load an unload file, because Unload Manager can help
you create a backup of your old data and reconcile conflicts during the installation of the unload; if
your application version is other than any of these, Unload Manager is not available and you can
use Database Manager instead.
To load an unload file using Unload Manager, follow these steps:
1. Go to System Administration > Ongoing Maintenance > Unload Manager.
2. Double-click Apply Unload. A wizard opens.
3. Select the unload file you want to apply, also specify a backup file, and then click Next. Details of
the unload file appear.
4. Double-click a conflicting object in the table to open the merge tool:
a. Merge the object, and then select the Reconciled check box.
b. Click Save to go back to the wizard.
5. Click Next after all the conflicting objects are reconciled.
6. Click Yes on the confirmation window to apply the unload.
7. Click Finish.
Now, the unload has been applied and at the same time your old data backed up.
To load an unload file using Database Manager, follow these steps:
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1. Make sure the Windows client is configured for server-side load/unload.
a. From the Windows client, go to Window > Preferences > HP Service Manager.
b. Unselect Client Side Load/Unload if is flagged.
c. Restart the Windows client.
2. Open Tailoring > Database Manager.
3. Right-click the form or open the More Actions menu and select Import/Load.
4. Browse to the unload file, and view the contents of an unload file before importing it by clicking
List Contents.
5. Make a backup copy of all files to be modified by this unload. For detailed steps, see "Backup and
backout instructions" on page 28.
6. Fill in the following fields.
Field

Description

File Name

Type the name and path of the file to
load.

Import Descriptor

Since unload files do not require an
Import Descriptor record, leave this field
blank.

File Type

Select the source operating system of
the unload file.

Messages Option — All
Messages

Select this option to see all messages
that Service Manager generates loading
the file.

Messages Option —
Totals Only

Select this option to see only the total
number of files Service Manager loads.

Messages Option —
None

Select this option to hide all messages
that Service Manager generates when
loading the file.

7. Click Load FG.

Web tier installation
The web tier update consists of a compressed file, sm9.35.6007-P6_Web_Tier.zip, which contains
both the installation files (the .war and .ear files) and the unload files that are required to install the new
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web tier. Installing the new web tier will upgrade your web client to this release level.
For installation instructions, see the Service Manager 9.35 Installation and Upgrade Documentation
Center.

New customers
You only need to install the new web tier using the .war or .ear file from the sm9.35.6007-P6_Web_
Tier.zip file in this release.

Existing customers
To upgrade your web tier to this patch level, you must back up and uninstall your old web tier, and then
install the new web tier. The upgrade does not automatically save your web tier customizations. To
keep your changes, you must back up your customized files and restore your customizations in the
new deployment.
Note: If you plan to deploy the web tier on Tomcat 7.0 by using the Tomcat Manager, you must set
the max-file-size and max-request-size parameters (default: 52428800) in the <Tomcat 7.0_
Home>webapps\manager\WEB-INF\web.xml file to a value greater than the size of the web tier
.war file, otherwise the deployment request will be rejected because the web tier .war file exceeds
the default maximum values. This restriction does not exist in Tomcat 6.0.
To install the new web tier, follow these steps:
1. Make the necessary backups. For more information about how to do this, see "Backup and
backout instructions" on page 28.
2. Delete or uninstall the existing web tier .war (or the .ear) file.
3. Clear the cache of your web application server.
4. Deploy the webtier-9.35.war (or .ear) file by following the instructions in the Service Manager 9.35
Installation and Upgrade Documentation Center.
Note: It is best practice to deploy with a unique context root. For example, /webtier-9.35-P6.
5. Use a diff utility to compare the new web tier’s web.xml file against your backed-up version to
ensure that any new parameters are properly merged into the files used in your final deployment.
Do this for application-context.xml as well as any other files you may have customized (such as
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style sheets and splash screens).
6. Make any new customizations that are necessary for your deployment.
7. Restart the web application server.
8. Check the version by clicking the HP logo (About HP Service Manager) icon.
The web tier version should be: 9.35.6007-P6.

Web tier application unload installation
The web tier package in this release includes the following unload files.

Unload file
QCCR1E19946_
SM933.unl

QCCR1E103581_
SM934_SM932.unl

Introduced
in 9.3x
patch

Used for
apps
version(s)

9.33

7.11, 9.21,
9.30, 9.31,
and 9.32

Enables extra columns in the "Attachments"
section of records.

9.32

Fixes this issue: The auto complete feature is
not supported by the web client.

9.34

Description

Associated server fix: QCCR1E19946

Associated server fix: QCCR1E103581
QCCR1E112070_
SM935_SM711.unl

9.35

7.11

Enables users to select multiple field values in
item options and save them to the cart item.

QCCR1E112070_
SM935_SM921.unl

9.35

9.21

Enables users to select multiple field values in
item options and save them to the cart item.

QCCR1E112070_
SM935_SM930.unl

9.35

9.30

Enables users to select multiple field values in
item options and save them to the cart item.

See Unload file naming convention for detailed information about the unload file naming convention.

Windows Client Installation
Note: No features are being added to the Service Manager Windows (Eclipse) client. We
recommend that Service Manager administrators deploy one of the other three clients (web client,
SRC client or Mobile Applications client) to end users. You still need the Windows client to perform
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administrative tasks.
The Windows client update consists of a compressed file, sm9.35.6007-P6_Windows_Client.zip,
which contains the executable installation files of the new Windows client. Installing the new Windows
client will upgrade your Windows cliexnt to this release level. This version of the Windows client comes
with an embedded JRE 1.8 (update 102).
For installation instructions, see the Service Manager 9.35 Installation and Upgrade Documentation
Center, which is available to download from the following Software Support Online (SSO) website:
https://softwaresupport.softwaregrp.com/km/KM01294561

New Customers
You only need to install the new Windows client.

Existing Customers
You need to back up and uninstall the old Windows client, and then install the new Windows client.
To install the new Windows client:
1. Stop the Service Manager Windows client.
2. Make necessary backups. For details, see "Backup and backout instructions" on page 28.
3. Uninstall the Service Manager Windows client. (Your connection and personalized settings are
retained.)
4. Run setup.exe from this Windows client patch to install the new client.
5. Check the version in Help > About Service Manager Client.
The client should be Release: 9.35.6007-P6.
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Windows Client Configuration Utility
installation
This release does not contain an updated version of the Windows Client Configuration Utility. You can
download the latest Windows Client Configuration Utility package shipped with the Service Manager
9.35 release. You can find the download links for the SM9.3x patches and release notes from the
Overview of Service Manager 9.3x Releases knowledge document.
For installation instructions, see the Service Manager 9.35 Upgrade Documentation Center, which is
available to download from the following Software Support Online (SSO) website:
https://softwaresupport.softwaregrp.com/km/KM01294561

Applications update installation
This release does not contain an applications or upgrade package. The latest applications version is
9.35. An applications upgrade is optional, and you can install the Service Manager 9.35 Applications or
Upgrade package according to your current applications version.
You can find the download links for the SM 9.35 Applications or Upgrade package as well as the
Release Notes from the Overview of Service Manager 9.3x Releases knowledge document.

Service Request Catalog (SRC)
installation
Service Manager 9.35.p6 includes the SRC package (src9.35p6.0013.zip), which contains the
following files:
l

A .war file for SRC 9.35.p6 (src-9.35p6.war)

l

Unload files for SRC 9.35.p6 and previous versions

Unload file naming convention
The unload files use the following naming convention: <CR_ID>_SRCxxxPxx_SMxxx.unl, where:
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o

<CR_ID>: The identification number of the applications defect that the unload file fixes. For
example, QCCR1E12345.

o

SRCxxxPxx: The minimum SRC patch level that requires the unload file. For example,
SRC935p1, which means the unload file comes with the SRC9.35 patch 1 and should be used
for patch 1 or higher.

o

SMxxx: The Service Manager applications version that requires the unload file. For example,
SM935, which means the unload file is intended only for Service Manager applications version
9.35.

SRC application unload installation
The SRC package in this release includes the following unload files.

Unload file
QCCR1M2359_
SRC935P4_
SM935.unl

Used
for
Introduced apps
in which
version
patch
(s)
Description
SRC 9.35
p4

SM935

After you apply this unload file, Service Requests
can be cancelled from the SRC user interface.

QCCR1E129134_ SRC 9.35
SRC935P4_
p4
SM935.unl

SM935

After you apply this unload file, the "request for"
person and "callback contact" person can update or
cancel the Support Requests from the SRC user
interface.

QCCR1E122984_ SRC 9.35
SRC935_
SM935.unl

SM935

After you apply this unload file, the configuration
data for the advanced search functionality in SRC
no longer gets lost when the application production
patch is applied for the second time.

QCCR1E122085_ SRC 9.35
SRC935p2_
p2
SM935.unl

SM935

After you apply this unload file, a lookup widget is
added to the advanced search field to display the
option list.

QCCR1E126654_ SRC 9.35
SRC935p2_
p2
SM935.unl

SM935

After you apply this unload file and execute the
script function, you can see the correct out-of-box
record for contact lookup window in SRC for
advanced search feature.

QCCR1E120868_ SRC 9.35

SM935

Enhances the SRC query hash algorithm.

Micro Focus Service Manager (9.35)

Page 51 of 58

Patch 6 Release Notes
Service Request Catalog (SRC) installation

Unload file
SRC935p3_
SM935.unl

Used
for
Introduced apps
in which
version
patch
(s)
Description
p3

Note: In this release, the English version of the online help is updated for Service Request
Catalog 9.35, while the localized versions are still based on SRC 9.32.
Before you proceed, read the Service Request Catalog 9.35 Interactive Installation Guide and Service
Request Catalog 9.35 Customization Guide available from the Installation and Upgrade Documentation
Center.
Note: Users who want to use Service Request Catalog on their tablet devices can download the
Service Request Catalog app to their device from Google Play or the Apple Apps Store. To locate
these apps, search for "HP SRC" in the appropriate store.
The Service Request Catalog 9.35 tablet app supports Service Request Catalog versions 9.34 and
9.33 (the SRC .war file).
New Customers
1. Deploy the src-9.35p6.war file by following the instructions in the Service Request Catalog 9.35
Interactive Installation Guide.
2. If there are unload files in the SRC zip package, you must load them into Service Manager by
using Unload Manager.
Note: Make sure to install unload files for previous patches at first if they have not been
loaded to Service Manager.
3. Configure SRC 9.35.p6 by following the instructions in the Service Request Catalog 9.35
Customization Guide.
Existing Customers
1. Install SRC 9.35.p6, as described above.
2. Migrate the customizations from your old deployment to SRC 9.35.p6.
Note: In the applicationContext.properties file, preceding asterisks (*) are added to the
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src.trustStorePassword parameter and the src.keyStorePassword parameter during SRC startup
if these parameters are not null. The system replaces the values of the two parameters with
encrypted strings, and adds a random key (randomRawKey) for the encryption. To update the TSO
certification and change the password, remove the asterisk and replace the encrypted string with a
new password. You must remove the random key and its value as well.

Mobile Applications installation
This release includes a new version of the Mobile Applications client (sm9.35.6003_Mobility.zip). New
customers can directly install the new Mobile Applications client by deploying the webapp9.35.6003.war file, while existing customers can only uninstall their old Mobile Applications client and
then install the new one.

Installation instructions
Note: The Service Manager 9.35 Mobile Applications client supports Apache Tomcat 7.0 (7.0.54
or greater) and IBM WebSphere 8.5 (8.5.5 or greater) web application servers.
For more information about how to install the Service Manager 9.35 Mobile Applications client, refer to
the Service Manager 9.35 Mobile Applications User Guide.
This patch includes the following two new unload files for mobility:
l

QCCR1E123225_SM935P3_SM932.unl, to fix QCCR1E123225

l

QCCR1E125623_SM935P3_SM930.unl, to fix QCCR1E125623

Enabling the Mobile Applications client when running applications versions 9.31
and 9.30
The Service Manager 9.35 Mobile Applications client can work with the SM9.3x applications (9.30
through 9.35); however, if you are running the SM9.31 or SM9.30 applications, before users can use the
Mobile Applications client, you need to make additional application changes by either importing or
manually implementing the following unload files in listed order:
l

mobile2-update-9.30-9.31.unl

l

mobile2-new-9.30-9.31.unl (If using the SM9.31 or SM9.30 applications with PDCP4 applied, load
mobile2-new-9.31-pd4.unl instead)

For more information, see the Service Manager 9.35 Mobile Applications User Guide.
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Enabling the Mobile Applications ESS user interface when running applications 9.3x
earlier than 9.35
The Service Manager 9.35 Mobile Applications client has already an employee self-service (ESS) user
interface enabled when working with the Service Manager 9.35 server and applications.
If you have upgraded your server to version 9.35 and are still running the 9.32, 9.33 or 9.34 applications,
you must load the MOBILITY_ESS_SM935_SM932.unl file to enable this interface.
If running Service Manager applications 9.30 or 9.31, to enable the ESS interface, you must enable the
Mobile Applications client for users first as described above, and then load the MOBILITY_ESS_
SM935_SM932.unl file.

Knowledge Management (KM) Update
Installation
This release includes a package for the Solr Search Engine (sm9.35.6007-P6_KM.zip).
Note: Tomcat 6.0.53 has been certified on this release of the KM Search Engine. Upgrading to
Tomcat 6.0.53 is optional but recommended.
To install the KM Search Engine update, follow these steps:
1. Stop your KM Search Engine.
2. Make a backup of your Search Engine installation folder and other necessary backups. See the
instructions in "Knowledge Management search engine" on page 34.
3. (Optional) Update the KM embedded Tomcat to version 6.0.53.
a. Download the Tomcat 6.0.53 zip file specific for your operating system.
Caution: The KM search engine requires a 32-bit Tomcat if running on a 32-bit operating
system, and a 64-bit Tomcat on a 64-bit operating system.
b. Extract the zip file to overwrite your existing Tomcat folder.
Caution: Before this step, be sure not to remove the embedded Tomcat folder, which
contains certain files that do not exist in the Tomcat 6.0.53 zip file that you downloaded.
This way these files will remain after you overwrite the old Tomcat folder.
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c. Copy your old Tomcat configuration file (server.xml in the conf folder) back to the updated
Tomcat folder.
4. Make sure you have already installed the SM 9.35 server package.
Note: The server package will update your schemastub.xml file to support the new features.
If you do not want to use the new features, copy your old schemastub.xml file back from the
backup of your server’s RUN directory so that your search engine can continue to work.
5. Copy all files and folders in the knowledgemanagement folder to your existing search engine
installation folder (for example: C:\Program Files (x86)\HP\Service Manager 9.35\Search_
Engine).
6. Restart your KM search engine.
7. Log off Service Manager and log back in for your changes to take effect.
8. Perform a full re-indexing for all of your knowledgebases.

Smart Analytics installation
The SM9.35p5 release does not contain a Smart Analytics package. You can download the latest
Smart Analytics package shipped with the Service Manager 9.35 release. You can find the download
links for the SM9.3x patches and release notes from the Overview of Service Manager 9.3x Releases
knowledge document.

ODBC Driver update installation
This release does not contain any ODBC Driver updates. The latest ODBC Driver package has been
shipped with the Service Manager 9.30p4, 9.30p5, and 9.31 releases. You can find the download links
for the latest ODBC Driver package and the release notes from the Overview of Service Manager 9.3x
Releases knowledge document.

Language pack installation
This release does not contain any language pack updates. You can download the latest language
packs shipped with the Service Manager 9.35 release.
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You can find the download links for the SM9.3x patches and release notes from the Overview of
Service Manager 9.3x Releases knowledge document.

Online help installation
This release does not contain any online help updates. You can download the latest online help shipped
with the Service Manager 9.35 release.

Service Manager online help
Service Manager 9.35 includes only an English version of the online help. For online help installation
instructions, see the Service Manager 9.35 Interactive Installation Guide that is included in the Service
Manager 9.35 Upgrade Documentation Center.
You can download the Service Manager 9.35 installation and upgrade documents, as well as the Help
Center, from the Service Manager Document Matrix.

Service Request Catalog (SRC) online help
The SRC online help is accessible from the product user interface. The English version is for SRC
9.35, and the non-English versions are for SRC 9.32.
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Send documentation feedback
If you have comments about this document, you can contact the documentation team by email. If an
email client is configured on this system, click the link above and an email window opens with the
following information in the subject line:
Feedback on Patch 6 Release Notes (Service Manager 9.35)
Just add your feedback to the email and click send.
If no email client is available, copy the information above to a new message in a web mail client, and
send your feedback to docs.feedback@microfocus.com.
We appreciate your feedback!
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